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Meeting venue
Meetings are held on
the last Wednesday of
each month (except
December) beginning
at 7:30pm, at Waimairi
School at the end of
Tillman Avenue, off
Bligh’s Road.
Drinks and snacks are
available while we all
calm down after the
excitement of the meeting.
Some members carpool to get to meetings. If you don’t have a car and
find it difficult to get to meetings, please contact a committee member to
arrange transport. Usually there is someone living near you who can
offer a lift.

Meeting programme
Wednesday 28th October 2009
Monthly Meeting
• Welcome and News
• Creaceed Prizmo Demo (see p14)
• AKVIS Sketch Demo (see Applebyte, April 2009)
• Google Earth
• Information Exchange
Come along and share your passion for Apple products. Learn
about the latest technology, and
enhance your skills. And meet
with old and new friends over
supper. Also remember to try
your luck with the evening’s
raffle. Visitors welcome.
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Submitting your article
Electronic submissions are preferred (to save wear and tear on my
fingers). Just choose whatever format suits and send it to:
editor@appleusers.co.nz
One page is roughly 450 words. Most article are less than 4 pages, but
longer articles may be accepted if of particular interest or relevance.
Please ask in advance if you are planning a longer article.
Please write clearly; short sentences are recommended to help you do
this. Use a spell-checker. If you are quoting some other article, please
include an acknowledgment of your source.
Pictures can help explain your article, so by all means include one (or
more) if appropriate. The format is not important - jpeg, tiff and gif are
all fine, but try to provide a high quality image (300 dpi) if possible.
For screen shots, you can use the build-in Apple functions Apple-Shift-3
or Apple-Shift-4, or a utility such as Snapz Pro, available from:
http://www.macdownload.com.

Next Deadline: 12 November 2009

Note: Apple missed the deadline for letting us know about their new
iMacs, revamped MacBooks, and extended Minis. And stylish mouse.
You don’t want to miss out as well, do you?

Prez sez
Hi AUGC Members,
Hello, October already! and the penultimate
meeting for this year.

Bart Hanson

The weather is good and I suspect some of you
have been paying less attention to your Macs
and maybe more to the garden or house of late.
I hope you find enough time to ferret out your
graphics tablets,
favourite fonts and
complimentary colour wheels as we are having
an art competition. Great prizes and a ton of
prestige to be won with the winners announced at
the November meeting on 25th November.
Please email your entries to myself at
president@appleusers.co.nz
by the 18th of November 2009.
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Looking at Apple's advertisement for the iPod Touch says something
about the way Apple itself sees the device. The headings say, "A Great
iPod. A Great Pocket Computer. A Great Portable Game Player" Under
each heading some extra text describes the things Apple sees users doing
with the device. "Game player", self explanatory. "Pocket computer",
mentions only internet connected apps, Web, email and maps. Things we
commonly associate with "Cloud Computing". Lastly, "A Great iPod"
music and videos games, apps.
The iPod Touch is a tightly controlled platform where every app you use
has been purchased from the iTunes Store. Apple can insist on this level
of control as the iPod Touch is essentially an iPhone without the phone
bit and the iPhone itself must be carefully controlled for security and
quality control reasons. You would not want the spinning basketball of
death in the middle of a call after all, would you? The touch interface is a
new and novel way to interact, all ones needs is to have a finger handy.
What about the touch experience on a supposedly larger device like a
tablet with a touchscreen? I expect that if Apple ever was to release such
a tablet, it would run the same OS as the iPhone-iPod Touch. For
everyday computing tasks such as creating and editing documents, I
forsee problems. First, a lack of accuracy from fingers hiding the work
with fine control of movement this sometimes requires. Mac OS X
already offers two finger scrolling, double tapping, pinching and
rotating, using the trackpad on a MacBook. One solution may be to still
have a cursor, this could follow ones finger, a centimeter or so in front.
Photoshop and
Microsoft Office
documents are
coming to the
iPhone.
Although I can
see that touch
based computing can be a whole lot of fun, I personally cannot see it
replacing my "proper" computer anytime soon.
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Apple's has recently given attention to the environmental effects of
manufacture, transport, usage, recycling and its support facilities.
Apple has also resigned from the US Chamber of Commerce mainly
because it disagrees with the chamber's lukewarm climate change
policies. "We would prefer that the chamber take a more progressive
stance on this critical issue and play a constructive role in addressing the
climate crisis," Catherine Novelli, a vice president of government affairs
at Apple, wrote to the business group.
The Washington Post reports that three other companies have also pulled
out because of the climate policies. Pacific Gas and Electric, PNM
Resources, and Exelon. A fourth company, Nike has resigned from the
Chamber of Commerce board, but remains a member.
Cloud computing may a very apt analogy as
data in "the cloud" has been dissipating,
dissolving into the ether, or just simply
disappearing lately.
T-Mobile, a cellular company in the States,
has an arrangement with Microsoft to
manage its Sidekick data on its customers
phones. Microsoft purchased the company which built Danger and then
built the Sidekick phone for the Danger software. The Sidekick's remote
data storage feature was ahead of its time and served as a selling point
for the device. It meant that if someone lost a phone, the contents could
easily be downloaded to a new one. But
the Sidekick didn't complement the
remote storage with a convenient way to
save all data locally. So, when the
Microsoft server crashed, ....
Most
newer phones, such as Apple's iPhone,
are designed to store data locally, and to
back up whenever the device is
connected to a computer.
On his blog (http://www.roughlydrafted.com) Daniel Eran Dilger says
Microsoft hired some PFY's (pimply faced youths) to write the code to
get everything shipped in time. Unfortunately the job was rushed which
lead to the current data meltdown. Daniel goes on to surmise that it
could be sabotage within Microsoft.
page 6 Applebyte

The Sidekick incident has demonstrated that having a local backup can
be essential, and raises a large warning flag about future Cloud
Computing.
Of course, bugs and lose of data are not the exclusive prerogative of
Microsoft. In late breaking news, 150,000 Facebook account
were unable to be accessed for a period of about a week, and
a bug has surfaced in Snow Leopard which can wipeout the
entire contents of a users home folder. It is possible
to turn off Guest Access in System Preferences >
Accounts > Guest Account. That’s it. Close System
Preferences and restart your computer. When you
next log in, you can choose whether or not you want to
r e enable the Guest Account. Doing so ought to protect your
data if you have upgraded to Snow Leopard already, since the Guest
Account will be recreated with all new
Snow Leopard settings which, it’s
assumed, won’t delete all your valuable
personal data.
Another System Software Update (10.6.2)
is nearly ready to leave the factory.
Jon Lech Johansen, a Norwegian hacker,
has released software to compete with the
iTunes Music Store named doubleTwist music store.
A company called Man & Machine has won a legal battle for the Mighty
Mouse name so Apple will have to stop using that name for its most
popular mouse.
Intel's top legal person, Bruce Sewell, has joined Apple's legal team as
Apple's new general counsel and senior vice president, the same title
when he previously worked with Intel Corporation.
Google released its new collaboration software called "Google Wave",
the same day as the Samoan tsunami; which was not too propitious.
Locally the government is putting the finishing touches on section 92a of
the pending amended Copyright Act.
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Special offers
Peter Fitchett
Note: These specials are available to all user group members.
Contact Peter (web@appleusers.co.nz) for access or coupon codes.
We actually got slightly ahead of our usual schedule last month the way
the dates fell, so there is not much new this month. To summarize what is
available:
O’Reilly Publishing
O'Reilly Publishing is offering user group members a discount of 35%
on all books and PDFs from O'Reilly, No Starch, Paraglyph, PC
Publishing, Pragmatic Bookshelf, SitePoint or Syngress books that are
purchased directly from O'Reilly by phone or online.
Visit them at http://www.oreilly.com/store/
Peachpit
You can save 35% on all Peachpit books by becoming a Peachpit Club
Member. Membership is free and easy. All you have to do is answer a
few questions in Peachpit's online survey, which you can access from
any book page. After you fill out the survey, you'll save 35% by entering
the coupon code at checkout. (You cannot use this discount in
conjunction with any other coupon codes.)
Apple user group members get 35% off the normal price . . . PLUS, if
you spend more than $55 (US) in one order, your discount will expand to
40%!!!
Visit and Join the Club: http://www.peachpit.com
Ebooks from Take Control
Take Control has supported Apple user groups with discounts and free
copies of their ebooks for many years. Their books cover many aspects
of the commonly used software that we use every day, and with updates
freely available, there is no excuse not to keep up to date.
AUGC members receive 35% discount.
Visit them at http://www.takecontrolbooks.com
Note: These specials are available to all user group members.
Contact Peter (web@appleusers.co.nz) for access or coupon codes.
For further specials, see our website.
page 8 Applebyte

Computers and Numbers
Bart Hanson
On our computers, we find numbers, words, colours, pictures, sounds
and videos. But behind all these, there lurks the secretive omnipotent
computer ‘bit’.
Computers are essentially binary manipulators. Everything is just ‘Off’
or ‘On’ - or as a number, 0 or 1.
For efficiency, the computer may group the bits together for different
uses: 3 bits can represent the numbers of the Octal (base 8) number
system (numbers 0 .. 7), and 4 bits can represent the Hexadecimal (base
16) system (numbers 0 .. 15 - these are often represented by 0 .. 9, A, B,
C, D, E and F). We are more used to the Decimal (base 10) system
(numbers 0 .. 9), so these other systems can take some getting used to.
Octal representation is not used very much these days, but hexadecimal
can be encountered in a number of different situations. Most commonly,
8 bits, or 1 Byte, is represented as 2 groups of 4 bits, or 2 hexadecimal
digits; (00, 01, 02, ... FD, FE, FF). In decimal, this is the numbers 0 to
255. You will see these hexadecimal pairs in your internet IP address
and IP mask (C0.A8.01.01 and FF.FF.FF.00), and in RGB colours
(33:CC:88)
Of course, computers can represent 10 - as 1010 (binary) or A
(hexadecimal) and 100 (1100100, or 64), but these are not ‘nice’
numbers in computerese. For larger numbers, ‘nice’ binary numbers that
have a value similar to our familiar thousand, million, etc are used. A
‘nice’ binary number near one thousand is 100,0000,0000, or 1024 in
decimal, and the computer will often use this and refer to it as a
thousand. It follows that:
1K (kilo-) =
1,024
1M (mega-) is 1024 * 1024 =
1,048,576
1G (giga-) is 1024 * 1024 * 1024 =
1,073,741,824
1T (tera-) is 1024 * 1024 * 1024 * 1024 =
1,099,511,627,776
1P (peta-) is 1024 * 1T =
1,125,899,906,842,624
So hopefully next time you hear that your hard drive is 250 Gigabytes or
even 1 Terabyte, you'll understand exactly how big that is. However, this
assumes that you know whether you know whether the computer is using
computerese, or real english when it tells you a number.
For disk sizes, up to MacOS X 10.5 (Leopard), sizes were specified in
computerese, so sizes appeared smaller than the manufacturer’s stated
disk size (in ‘real’ decimal) - your 250GB disk would appear to be only
230GB according to your computer.
In MacOS X 10.6 (Snow Leopard), your computer will now use ‘read’
decimal numbers, so the same disk is now 250 GB - it appears to have
grown bigger, but it is actually still the same size!
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Christmas Competition
Your mission, should you accept it, is to produce a prize winning digital
artwork suitable for printing on an A4 page.

Art

is the process or product of deliberately arranging
elements in a way that appeals to the senses or emotions.
Should you accept this task, the sky is the limit - provided it has been
generated on a computer and emailed to President Bart. He will print out
the entries in glorious technicolour and subject them to judgement by an
independent art critic appointed by the committee, in time for
announcement and display at the November meeting.
Your artwork may be
generated pixel by pixel or
abstracted from an existing
photograph or other image.
It may be calligraphic or
pictorial, cartooned or
straight, topical or
timeless, political or
spiritual, serious or
humorous, adult or
juvenile or anything
within, between or beyond
these parameters.
But please keep it legal,
and we want to be able to
display it without blushing
too much!
The judge's instruction will be to choose the best work of art - not the
most ingenious use of a computer and then to choose three works
deserving of merit awards.
Submission
Save your artwork as a jpg, not more than 5MB
in size.
Email to
president@appleusers.co.nz
with Competition in the subject line.
to arrive not later than
5pm, Wednesday, November 18.
There is no limit to the number entries you may
submit, but we expect you to be reasonable!
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Itʼs Free
Free On-line Access to OED
I still have on my computer an early Mac version of the unabridged OED
(Oxford English Dictionary). But because it runs only in Classic, since
moving to OS X I have found that I am using it less and less frequently
because of the need to launch Classic to access it. After having for many
years stopped support for the Mac, Oxford University Press has recently
again brought out a Mac version of the OED (for 10.4 & 10.5), although
the price (£169.57) is probably somewhat prohibitive for most of us. But
did you know that anyone who is a member of Christchurch City
Libraries has free on-line access to the OED?
All you have to do is create an on-line account and go to Databases
(http://christchurchcitylibraries.com/Databases/), where under “Art,
music & literature” you will find the Oxford English Dictionary. It is
also well worth checking all the other on-line resources that are
available. As a Banks Peninsula resident, I have since discovering this
unexpected benefit of library membership almost become reconciled to
Banks Peninsula’s amalgamation with Christchurch a couple of years
ago.
Rolf Giebel
There are also many other reference books available in this Database
section, so why don’t you have a look? I tried and found that I didn’t
have a pin-code to log in to the online library system. A quick phone call
- it was still library hours! - and I had the required pin, so I logged in and
navigated a couple of screens to the Database section, then tried to log in
again to see to OED - and my user sign on had EXPIRED! Luckily it
was still library hours, and another phone call got the expiry cancelled
and I was able to log in to see the OED.
Ed.
Free On-line Access at Library
Have you caught up with the information that libraries throughout the
country are installing open-access wireless networks.
Anyone is
welcome to pop into any library and use the network - some are asking
that you sign a sheet so that they can keep track of demand. (The
network is only available when the library is open.) Alternately, you can
sit in your car parked on the side of the road - within 50-100m of the
library, and you should be able to get a connection. It is rather strange the
out of the way places where we had to stop on our recent holiday in
Northland - coincidently a library was always nearby!
Ed.
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Review - MemoryStick
Tony Mander

MemoryStick, a free utility showing RAM usage
Today, RAM (Random Access Memory) is cheap and is one of the
easiest ways of maximising the speed of your Mac. If you are going to
handle large documents or intend to do photo editing then it is wise to
have sufficient RAM installed when you buy your Mac. It is only with
the most recent models that Apple has included sufficient RAM to be
useful. In the past we always had to buy additional RAM.
So how do you know if your has sufficient RAM? Ideally, you need
enough RAM so that an application doesn’t have to use the hard drive
(HD) to store less-used resources, as this is very much slower than solidstate RAM. Prior to OSX we used to allocate blocks of memory to each
application, and we could see how much of its allocation was actually
used and tweak the allocation accordingly – essential when RAM cost
around $100 per Mb in the early 1990s.
In MacOS X, RAM usage is constantly changing, as applications load
into RAM only those resources it actually needs at that moment. What
you need to avoid is having too many resources swapping between RAM
and the HD, as things really start to slow down, and you may even see
the ‘spinning ball’ icon. While the Activity Monitor application (in your
Utilities folder) will show you this, it does so in mind-numbing detail,
although it has an option (View>Dock Icon>Show Memory Usage) to
show RAM usage as a pie graph. However, if you use small Dock icons,
or hide the Dock, it isn’t of much use. MemoryStick is free, is very
small, and can float so it is always visible. It need only be run a few
times to gain an idea of RAM usage.
MemoryStick shows:
•

The proportion of RAM
being used, shown as
vertical or horizontal bands
(Options>Toggle Orientation), may be resized
(Preferences>Size).

•

RAM use in MacOS X categories: wired (essential,
so must always be in RAM); active (recently used,
so in RAM); inactive (in RAM but not recently
used, so will be swapped-out if RAM is
needed); free (memory not used, generally
high only at start-up). 'Hover' the mouse
over one of the categories to see actual
percentages. The colours of each are defined
in Preferences>Colors.
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•

The frequency of page-outs (how often RAM contents are swapped
to/from the HD), show at the bottom of the window, which blinks
each time a page-out occurs.

•

The number of swapfiles
(If RAM is insufficient,
the least recently-used
information is 'paged-out'
of RAM and temporarily
stored on the computer
HD 'swapfile' area, and if
required again will be
'swapped-in' to RAM to
displace currently leastused information. Note
that programs can not be
run directly from a swapfile, they must be in RAM.) This screen
capture shows 1 swapfile; 'hover' mouse to see size of swapfiles
(64Mb in this instance).

The Help file gives a full description of how MemoryStick works and
how OSX handles memory. It's worth a read just for the information.
MemoryStick, useful and free software by Matt Neuburg
http://www.tidbits.com/matt/
Scroll down to Things Having To Do With Cocoa section (or click the
'Cocoa things' button on the left), where amongst other useful
applications is the download link for MemoryStick. The current version
(1.5) is for Tiger/Leopard (10.4+), versions for earlier versions of OSX
are also available.

iMumble 19.0
Barry Clark
iNvest
We usually iNvest in shares or whatever for personal profit. Do we really
care what the company does?
iT looks at though we are going to allow anyone to iNvest in New
Zealand. That means overseas iNterests buying companies and land,
taking the profits off-shore then, at the end of their iNterest, selling iT
back and taking the capital gain out as well.
Um ...... that's an iNterest-bearing loan, iS'nt?
Ed: Perhaps what we need to do is to iNvest in overseas companies to be
able to bring their profits back to New Zealand - I have heard that
marbles may be a good iNvestment!
Applebyte page 13

Creaceed Prizmo
Prizmo 1.1
or how to scan without a scanner!
Do you want to:
• archive your invoices and make them Spotlight indexable?
• save your receipts on a hard disk for the day you might need them?
• get rid of the business cards which are all over your office?
• copy a document although you don't have a copier at home?
• scan a page in a book that doesn’t fit on a scanner?
• scan an image that is too big, or out of reach?
• save time when you need to scan a document?
• avoid carrying a scanner around with you?
• etc.
From now on, if you can take a picture of something with your digital
camera, you don't need to buy a scanner anymore. Save money and room
in your house/office. Use Prizmo instead to scan your documents!
How does Prizmo work?
1. Take a picture of your document.
2. Import it into Prizmo.
3. Select the part of the photograph you need.
4. Easily process the image in a few clicks (change brightness,
contrast, height and width... and perspective).
5. Drag and drop it to your desktop.
6. Send the image by email, print it, save it on your computer or on an
external disk... as you like it!
Optical Character Recognition (OCR)
OCR on the Mac? Yes, we integrated the technology of a world famous
OCR specialist, ExperExchange Inc., into Prizmo, and released a userfriendly and reliable solution all Mac users can afford. So, you can really
do without a scanner, even more now.
Prizmo's character recognition technology supports 10 languages
(English, French, German, Dutch, Italian, Spanish, Portuguese, Swedish,
Danish and Norwegian). And the results are Spotlight indexable.
How does OCR work?
1. Take a picture of your document.
2. Import it into Prizmo.
3. Select the part of the photograph you need.
4. Choose the text language.
5. Set the binarization level.
6. Choose the file type for saving the OCR results (PDF, RTF...), and
that's it!
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Does Prizmo support all cameras?
Compact cameras, DSLRS,... every digital camera is fine. The higher
resolution the better of course, but you can get good results even with
your iPhone camera. Nowadays, cameras often have 10 megapixel
sensors. A 10 megapixel image is roughly as good as, or even better than
a 300 dpi US-Letter scan. With some image processing improvements
and binarization, you can even go beyond 600 dpi with such images.
Is scanning limited to documents?
No, it isn't. As Prizmo corrects lens distortion and perspective as well,
you can scan almost everything. Even if you take pictures with your
mobile phone when you are out and about.
Community-based Camera Calibration
Calibrating your camera can help you achieve better results when you
use Prizmo. With a good calibration model, Prizmo can indeed better
correct lens distortion on your photographs.
Prizmo accesses a calibration model database on Creaceed's servers:
• You can download the best models available for your camera.
• When you calibrate your camera, you decide whether or not you
share your calibration model with the other users of Prizmo.
Try the free demo version now:
http://www.creaceed.com/prizmo/
Mac User Group members: 20% discount until 31st December 2009

Whether you’re a student, creative professional,
designer, home user, or games enthusiast, we have
a Mac to suit your needs from the amazing small
Intel Mac mini to the awesome Xeon powered
Mac Pro. We also stock a comprehensive range
of peripherals.
t We sell all Apple products: iPods, iPhones,
iMacs, Macbooks, MacBook Pros, Mac Pros
and Mac minis
t Accessories and consumables
t Extensive range of software
CHRISTCHURCH STORE 200 Moorhouse Avenue · Christchurch
Ph 03 366 5454 · Fax 03 366 4456 · www.magnummac.co.nz
Hours: Mon-Fri 9.00am-5.30pm Sat-Sun 10.00am-5.00pm
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This month in UK
Nigel Cooper
Well, here I am on a train travelling from London to Newcastle. I saw a
three pin plug in the wall and thought, "I wonder what would happen if I
plugged in my laptop?" I did, and, hey pesto–it worked! A wireless
connection was made with the train's SMTP (whatever that is) and I can
receive and send emails. Which is more than I could do from my friends'
homes on the first three days. I could receive, but not send. I kept getting
messages asking me to register something, which required downloading
a page, filling it in by hand and faxing it off. I have no printer, of course,
so was stymied.
It turns out that the cause of this is that Paradise in NZ thinks that my
emails were spam. It would let through one from wherever I am, then
stop everything after that one. Same thing next day from somewhere
else.
I got round the problem up till now by opening Safari, googling Paradise
and clicking on 'Mail' on their home page. Then composing messages
and sending them that way. It works, although it's a bit clunky to use and
slow to open. But at least I got messages away.
Now for an item I read in The Daily Telegraph today (16 October): ":The
brain uses predictive text". "Scientists have found a built-in predictive
text function in the brain that acts like that on a mobile telephone and
explain why it is possible to finish someone's sentences. Researchers
believe dyslexics are missing this ability and hope their discovery,
published in the journal 'Nature', could lead to new treatments for
sufferers."
Apparently the brain predicts what it is going to see rather than interprets
what it has already seen. Great discovery! This can be confirmed by the
way you can 'read' text in which the middle letters of a word have been
jumbled up. Foir intasnce, this souhld not be too dufflcit to raed!
The brain seems to know what you mean by the first and last letters, and
the other letters even when mixed up, and almost instantly guesses the
correct word. Perhaps that's why youth of today are so good at texting!
Their language is gobbledygook to me, but they seem to communicate
just fine!
Cheers
Nigel is searching the
UK for an interesting
Chess game!
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Useful Utilities
Tony Mander
Some of the utilities/add-ons I find useful are iStat menus, Little Snitch
and CoolPreviews. They require OS X 10.4 or higher.

iStatMenus
http://www.islayer.com/apps/
iStat Menus is freeware although a donation would obviously support the
continued development of this little gem. It consists of several
components, accessed through the System Preferences panel, where it
appears in the 'Other' group. It has several components each of which can
appear in the menu bar as required; they are: CPU activity; Memory
usage; Disk usage; Disk activity; Network activity; Temperatures of
CPU, fan activity and HD temperature (requires a separate HD
temperature sensor installation); Date and Time.
I find the Date and Time component most useful. Over the years I have
tried several calendar utilities, and so far this is the most unobtrusive yet
most useful. The menu bar view shows the date (yes, I can still
remember the month!), day and time. Clicking on the menu bar calendar
icon displays a drop-down calendar (you can click through the months if
needed) along with world clocks (you add as many as you want), and
links to iCal.

Drop-down
panels
Applebyte page 17

I also now display memory and HD space icons as well after an episode
while working on a job with InDesign: it suddenly informed me I'd run
out of disk space, less than 10 Mb was left and dropping, and I should
urgently save the file. Somehow, according to the Finder, 183 Gb of HD
space had disappeared!
My immediate concern was whether my backups were up-to-date (yes!),
and then what the #!$!*?! was going on?! (A restart solved this particular
gremlin, whatever it was.) The disk and memory graphs take up very
little menu bar space, and the drop-down menus are very informative. I
like to have about 8 of my most frequently used applications open all the
time, so it's good to be able to monitor memory and disk usage to see
what's happening.
If you want this as a widget, there is iStat Pro (current version: 4.9)
which will monitor CPU activity, memory use, disks, network, battery,

15% DISCOUNT SEE BELOW 15% DISCOUNT SEE BELOW
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temperatures, fans, etc.
Another similar utility is MenuMeters
(http://www.ragingmenace.com/software/menumeters/).

Little Snitch 2.2
http://www.obdev.at/products/littlesnitch/index.html
Little Snitch is not freeware. I obtained it through one of the occasional
MacUpdate bundle offers (http://www.macupdate.com),where several
useful applications are offered at a fraction of the normal price. While
you get some you may not want, the cost is still low enough to be worth
it. As it turned out, Little Snitch wasn't one of the applications I was
wanting when I opted for this bundle, but I installed it out of curiosity. It
is now one of my near-indispensable utilities, especially in this age
where identity theft and online data gathering is so common. Little
Snitch is really a part of your firewall, monitoring the websites you
connect to. It is surprising how many 'ordinary' websites have links to
website-use monitoring sites or advertising popups, and how often
applications want to "phone home", presumably with usage statistics as
for most I have update checking specified manually. It is very satisfying
when Little Snitch pops up a window asking whether you want to
'Accept' or 'Deny' the requested connection and to click the 'Deny'
button! Accepting a connection adds it to your list of approved sites, so
you aren't continually being nagged (unless you want it that way). Little
Snitch gives you a list of approved sites. It assumes that if you have
navigated to a site then it is an 'Accepted' site; it only pops up a warning
if that site then activates links to other sites. In the past I would never
have known of this background linking, most of which would not be for
my benefit.

Network Monitor

Rules Window
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CoolPreviews 2.7.6
http://www.coolpreviews.com
This is a browser add-on for Firefox v.2 or higher, I'm using it on v.3.5.3
with no problems. (FYI: it's also available for Explorer 6, but not v.7 or
8 . . .)
It allows you to display a link without leaving the page you are on. I use
tabs a lot, but find being able to see a link without having to leave the
current page (ie. without creating a new tab or window) is very
convenient. To display the preview window of a link, first hover your
mouse over the link (or click it, depending on your preference settings)
and then over the CoolPreviews icon that
appears beside the link. The preview window
appears inside the current page window. You
can move or resize it (it remembers the new size) and scroll through it as
for any page; you just can't move it outside the current page window. To
close the window either click the close button (top right) or click outside
it on the current page. The preview window can remain open by clicking
the 'Lock' button on the toolbar.
If you want to then
open the link
window in a tab
there is a button on
the toolbar which
will do this when
clicked.
It also has the
ability to create temporary bookmarks on the right
side of the window, referred to as a 'stack',
presumably because they appear as a stack of
thumbnail buttons beside the vertical scroll bar.
The stack remains until you click the stack 'close'
button or until the Firefox window is closed.
You can use the preview window back and
forward arrows as for any websites displayed.
Search and email options are available from
contextual menu (right/ctrl-click) or from
toolbar. Email requires registration with
Cooliris site, so far I've not had occasion to
(copying and pasting the URL is fine).

the
the
the
use

Preferences, disable and uninstall functions are
available from the Firefox Tools>Add-ons menu;
Preferences and disable functions are also
available from the CoolPreviews button at the
bottom of a browser window.
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The speed of loading of a preview is much the same as that of the
website in a tab or window.
The instructions and video
tutorials on the website are clear
and easy to follow. It has many
features, but I find the simple
display of links is the most
useful.
Note: When you install new software (a new version of MacOS X, or of
Firefox browser), you will probably need to reinstall these utilities. You
should take the opportunity to check that you have any new version of
the utility at this time.
Ed.

"There is no such thing as an insignificant improvement."
- Tom Peters
"Technology is a way of organizing the universe
so that man doesn't have to experience it."
- Max Frisch

SeniorNet Mac
Computer Training Lessons: Two-hour sessions, once a week for four
weeks. Course notes are provided. Classes are small with a maximum of
six students and two tutors per lesson.
Social Events: Held on the fourth Tuesday of the month.
Newsletter: Supplied every two months.
The Learning Centre is situated in the Cranmer Centre Poolhouse,
which is accessed from Montreal Street at the Armagh Street corner.
Contact: If you would like to join SeniorNet Mac and are in the 55-plus
age group, please contact Allan Rutherford at (03) 352-4950, or email:
ajmr@xtra.co.nz,
or else leave a message on the club’s answerphone at (03) 365 2003.
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Reviews: Photoshop CS4
Maria O.Arguello

Photoshop CS4, The Missing Manual
by Lesa Snider King
Publisher :
O’Reilly
ISBN :
978-0-596-52296-4
No. of Pages:
776
Price :
$49.99 (35% off for MUGs)
Level :
Intermediate/Advanced
Date :
November 2009
Reviewer :
Maria O. Arguello
Rating :
5 out of 5 apples
The O’Reilly Missing Manual Series are near and dear to my heart. My
private library holds a significant number and they are my first resource
when I need a quick answer to a question. Lesa Snider King’s, Photoshop
CS4, The Missing Manual (for Macs and Windows) is one of my
favorites.
The tome composed of 776 pages is coherent, informative, and full of
useful content. It is sufficient for all who feel one book is enough. The
numerous color graphics pop and are one of its many strengths. I used to
hate the black and white illustrations that were once upon time popular
for books about improving images. Duh?! Thank you O’Reilly. The
index is well done and very valuable and useful.
Lesa’s writing style is clear and amusing. Her sense of humor comes
through making this book an easy read. Her uncomplicated explanations
for very complex topics are remarkable. The reader will chuckle.
The author’s experience and expertise with Photoshop is an asset which
dazzles in her narrative. The organization of the subject matter flows in a
logical and straightforward manner.
When I read the section about Super Slimmers, I couldn’t help but be
reminded of the Ralph Lauren Photoshop fiasco. The photo was widely
distributed and discussed over the Internet as an example for overdoing
Photoshop. If you missed it, you weren’t on planet earth. Check it out at:
http://tinyurl.com/yglk4ga.
David Pogue, the creator of The Missing Manual series, wrote in the
Foreword, “Thanks to Photoshop, photography is no longer a reliable
record of reality.” How true is that.
This is the book that should have been in the box with Photoshop CS4.
Buy it.
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iPhone App: Adobe Photoshop CS4 Learn By Video
Companies:
Peachpit Press, Adobe Press, and Video2 Brain
URL:
App Store
Price :
$1.99
System
Requirements: iPhone 3G, 3GS, or iPod touch
Reviewer:
Maria O. Arguello
Rating:
4.5 out of 5 apples
The Adobe Learn by Video Series are brought to you by Peachpit Press,
Adobe Press, and Video2 Brain. The iPhone app is like having a teacher
in your pocket. I downloaded it from the App Store and watched all three
lessons for Adobe Photoshop CS4: “Covering the Basics,” “Image
Editing,” and “Creative Photoshop.” I was very skeptical that I would be
able to get much from a tutorial on such a small screen. How was I going
to see the cursor? But the resolution of the video and zooming into the
area being explained led to a clear visual of the narrative.
The tips for taking charge of Photoshop's Interface were helpful and big
time- savers. The three lessons are well developed and useful and the
developers have done a great job on this video. I look forward to more
iPhone apps like this one.
The app lets you send comments and you can also take quizzes. You can
search a topic and it will give you several videos from which to choose.
Note:
I contacted Peachpit regarding the complete tutorials and they responded
that right now there are three DVD products available in the Learn By
Video Series, which retail for US$59.99 each.
• Learn Adobe Photoshop CS4 by Video: Core Training in Visual
Communication (19 hours of video)
http://www.peachpit.com/title/0321634934
• Learn Adobe Flash CS4 Professional by Video: Core Training in Rich
Media Communication (15 hours of video)
http://www.peachpit.com/title/0321635000
• Learn Adobe Dreamweaver CS4 by Video: Core Training in Web
Communication (14 hours of video)
http://www.peachpit.com/title/0321635019
No word yet, on the InDesign one.
©2009 Maria O. Arguello. Maria is a reviewer for the Macintosh user
group community and the vendor liaison of the Macintosh Users Group
of South New Jersey (MUGSNJ). Maria is also a member of MLMUG,
NCMUG, PMUG, MUGSNJ, PPUG, and SJAUG. She is the Apple User
Group Regional Liaison for the Northeast United States (CT, DE, MA,
MD, ME, NH, NJ, NY, RI, VT).
Both reviews reprinted with permission; Thanks, Maria.
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Bugs to watch for
Peter Fitchett

Snow Leopard and ʻGuestʼ Accounts
Apparently, if you have a ‘Guest’ account on your Mac under Leopard
(MacOS X 10.5) and upgrade to Snow Leopard (MacOS X 10.6) then
when you:
log into the ‘Guest’ account,
log out
log into an ordinary account
then the bug strikes and your Home folder (the one with all your
document, photo, movie and music files) is replaced with an empty
folder. The Desktop and Dock revert to an “out-of-box” condition.
Now this is rather drastic for a bit of spring cleaning, and is best avoided.
What I also find interesting after seeing all the headlines appear
suddenly in publications around the world - is that this was actually
reported in public forums over a month previously without a murmur in
the press!

Mail and TimeMachine
(This may also be relate to Snow Leopard)
Mail uses a file to keep track of the last email it has already received, for
each of your POP email accounts, so that it just requests newer emails
every few minutes. If TimeMachine is backing up that file when Mail
tries to access it, a conflict occurs, and Mail thinks that it has not
received any previous mail - so it downloads all emails available from
the ISP. This can result in duplicate copies of emails being received.
Apple Support has provided a work-around ... if this is happening to you.
• Navigate to your Home folder, to the Library folder, to the Mail folder,
where you will find the file:
MessageUidsAlreadyDownloaded3
• Close the Mail program and remove this file, then restart Mail. The file
will be recreated when Mail next tries to received any emails.
• Now open you TimeMachine preferences, Options button, and drag the
new file to the TimeMachine ‘Excluded Items’ list. It will no longer be
backed up, and the conflict won’t reoccur.
• Oh, and by the way, all your emails will once again be downloaded
(and duplicated) because you removed that file; but this will be the last
time!
Quote from Apple Support:
“There haven’t been any changes for Snow Leopard - they have just
re-engineered it [Mail] for 64-bit.”
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Snow Leopard tip
Opening Files
MacOS X keeps all sorts of information about each file (this is called
metadata). One of the items kept about data files is a note of which
program created the file. In all versions of MacOS X prior to Snow
Leopard, this creator code information (assuming you don’t override it
using the Finder’s Open With contextual menu) lets the system know
which application to use to open a the document. This would work
regardless of the extension at the end of the file-name.
In Snow Leopard, creator codes no longer play this role—while they can
still be assigned by the creating application, they (probably) won’t work
as you expect them to, especially if you’re a long-time Mac user.
That’s because Apple has arbitrarily changed the role creator codes play
in determining what application will open a give document. In Snow
Leopard, applications are opened based on the user’s setting in the Get
Info window; if that setting hasn’t been changed, then the document is
opened by an application deemed to handle that file type, using
information maintained by the system’s Launch Services routine.
That file type is determined by the extension at the end of the file-name!
This sounds quite confusing, so let’s look at a real-world example.
Created a pure text file in Smultron (a text editor), and saved it as
my_text.txt
Created a new HTML document in BBEdit, and saved it as
web_page.html.
Created a new image in Photoshop CS3, and saved it as a Photoshop
file named web_image.psd.
Exported a web-ready image from Photoshop CS3, saving it
web_image.png.
In OS X 10.5 if you switched to the Finder, and double-clicked each file,
there were no surprises at all—each file opens in the application used to
create that file. To a user, this makes perfect sense, and is the Mac-like
behavior we’ve grown accustomed to over all these years.
In Snow Leopard, however, the results were notably different…and quite
disconcerting. The Photoshop file opens in Photoshop, but that is the
only file that behaved “correctly”—or at least in a manner that made
sense to us old-hands. The Smultron-created text file opens in TextEdit,
the Photoshop-created PNG opens in Preview, and the BBEdit-created
HTML file opens in the default Web browser (usually Safari).
This new behaviour is what we will have to learn to expect from now on
- just be careful out there, and watch those file extensions!
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Round-up
Peter Fitchett

Glo
A new interactive e-Bible was published on 15 October, but with
interesting features and restrictions. The publishes are reported to have
said that it will only be available on the PC (although their website says a
Mac version will be available next year!) In a radical move, online
updates will be available. As the last update to the Bible was about 1500
years ago, I am not sure what the publishes know that we don’t, we are
not sure whether you should hold your breath for an update, or not.
Perhaps this reflects the difficulty in updating paper copies? A surprising
restriction is that Glo can only run on individual PCs - network installs
are not allowed (so much for omnipresence!)
The chosen system requirements include Windows 7, Vista and XP (the
chosen 3) and a dual core processor is mandatory (perhaps Intel should
make a tri-core processor to provide the true 3-in-1 experience).
Check out the website at
http://www.bibleglo.com/
and see if you can’t wait until next year. Only US$89.99 (in the US only)

Light Peak
On the subject of new products ‘coming’. Intel have demonstrated a
proposed optical standard interconnect cable to handle massive amounts
of data - using a glass-fibre. The concept is not new - glass fibres have
been in use for many years to transmit data - in trans-oceanic phone
cables, in Telstra’s cables in Wellington & Christchurch, and even within
some professional high-performance (and expensive) computer systems.
Intel have developed a cheap, plugable technology that will allow this
high performance to be used as easily as the current USB cable - and it
could be available in the market as early as next year!
According to rumour, Apple (Steve Jobs himself) reached out to Intel as
early as 2007 with plans for an interoperable standard which could
handle massive amounts of data and replace the multitudinous connector
types (FireWire, USB, Display interface, ethernet) with a single
connector. This solution could certainly simplify all those plugs on the
side of a laptop, and remove many of the current cable length
restrictions.

Radio
Now that we are back in the rumour area, Apple are rumoured to be
developing an FM Radio app for the iPhone/iPod Touch. It will have
similar capabilities as the iPod Nano FM radio, including live pause and
fast-forward. (Fast forward into the future is not supported initially!) The
app may integrate with iTunes so you can purchase a song that you hear
on the air. Hear it, like it, tap it - and there goes the bank balance.
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More for the iPhone/iPod Touch
iSoftQuik (http://www.isoftquik.com) advise us that they have release 3
new apps for the iPhone/iPod Touch:
C What-I-Spent,
PlanMyEvent, and
ProjectMgr
If you are interested in reviewing any of these, please contact the Editor.

Reviews
While on the subject of reviews, we get offers of the availability of
software and books from time to time. If you would like to be on the list
to review any of these (and usually get to keep the item if you want it)
please let the Editor know. Some items don’t get reviewed at present.

Planning a new home?
Home Design Studio is now available for the Mac. SmithMicro Software
have partnered with Punch! Software to offer the best-selling, benchmark
home design technology to Macintosh users! The introductory price is
just US$49.00.
Punch! Software’s Home Design Studio has been voted the #1 home
design and landscape software for eight years running.
You should note that SmithMicro Software are selling the old version of
this product - but you can then upgrade to the current version for a
further US$19.99 directly from Punch! Software. Still a pretty good
saving from the regular price of US$149.00.

Aquarium
The Marine Aquarium 3.0 screensaver is now available with 25%
discount for a limited time - (US$19.95).
http://www.novadevelopment.com/

AUGC contacts
Website

http://www.appleusers.co.nz

Mailing Lists

Peter Fitchett
listadmin@appleusers.co.nz

(3) 960 8189

The AUGC Discussion List is for members who
wish to discuss club matters.
The HELP list is open to all Mac users who wish to
give or receive assistance.
Membership

treasurer@appleusers.co.nz
with printed Applebyte:
$45 per annum
without printed Applebyte
$25 per annum
($5 discount for early renewal)
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About the user group
Aims

The
Apple User Group of Canterbury
Incorporated (AUGC) is a non-profit
organisation which exists for the purpose
of exchanging ideas and expertise about
the use of Apple
computers,
the
Macintosh operating systems, and related
hardware and software.

Committee
Patron

Murray Wood

President

Bart Hanson
president@appleusers.co.nz
Noel Strack
vicepres@appleusers.co.nz
Jim Pollard
secretary@appleusers.co.nz
Raewyn Saunders
treasurer@appleusers.co.nz
Peter Fitchett
editor@appleusers.co.nz
Mike Han
michael2049@gmail.com
Eion McIntosh
emci@xtra.co.nz
Peter Tuffley
ptuffley@xtra.co.nz

Vice-President
Secretary
Treasurer
Committee

Help:

(3) 384 5510
(3) 355 4546
(3) 358 7943
(3) 384 8070
(3) 960 8189
(21) 867 426
(3) 383 1228
(3) 332 7951

A full list of helpers and volunteers can be
viewed in the Contacts section of our website.

Snail Mail: PO Box 31–053, Christchurch, New Zealand.
Website: http://www.appleusers.co.nz

